
Agenda 
District 7 TransCAD Training – Part 3 

 
Day 1 (December 13, 2016): 

• A brief refresher on basic TransCAD topics already covered in the first session,  
• Group practice creating a complete map 
• Detailed review of assignment results 
• SR-126 Air Quality Step-by-Step (full manual process) 

 
Day 2 (December 14, 2016): 
 

• Placing the map on a layout and printing or saving it 
• Editing networks (adding/dropping lanes including HOV lanes, and ramp/interchange edits) 
• Running Traffic Assignment with a modified network (full step by step process – example) 
• Working with trip tables (TAZ aggregation, desire lines, small county to county comparisons, 

TLFDs)  [As time permits] 
• Select Link/Zone Analysis [As time permits] 
• Subarea extraction [Likely to be in a future session] 
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Review: TransCAD and SCAG 
Model Basics
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SCAG Model File Structure
SCAG

16R12by_set7_setting

16R16s3_set7_setting

…

16R40s1_set7_setting

16R40s3_set7_setting

Validated base year (2012)

Short-term 2016 forecast

Various interim years (e.g., 2020)

2040 “Baseline”

2040 “Plan”
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SCAG Model File Structure
16R16s3_set7_setting

Assign

Emission

ExtHDT

ExtLM

Geography

Raw traffic assignment results

Assignment factored to HPMS
(for AQ modeling)

Heavy truck external/port/airport trips

Light/Medium vehicle external/port/airport

Useful layers for mapping (TAZs, RSAs, etc)

Key Outputs

Key Outputs
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SCAG Model File Structure
16R16s3_set7_setting

Interim

msplit

Networks

ODTable

Reports

For internal model use

Mode Choice Model

Roadway network files

Vehicle Trip table matrices

TransCAD Logging Information

(Continued)

Key Inputs

Key Outputs
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SCAG Model File Structure
16R16s3_set7_setting

SED

Skims

TOD

Tripdist

Tripgen

Socioeconomic Data

Shortest Path Matrices

Time of Day Model

Trip Distribution Model

Trip Generation Model

(Continued)

Key Inputs
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SCAG Model File Structure
16R16s3_set7_setting

Truck

User

Internal Heavy Duty Truck Model

For troubleshooting / SCAG use

(Continued)
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SCAG Model File Structure
Networks

Inputs

Outputs

Reports

Files provided by SCAG.  Changes made here

Files generated by the model.  Do not change.

Model result summary tables

All folders have a the same structure
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SCAG Model Scenarios
Start the Add-In
» Tools  Add-Ins 

SCAG Model v 6.3

Setup a Scenario
» Click “Setup”
» Find the scenario to run

 Example: 16R16s3
 Make a copy or work in place – But KEEP TRACK

» Set the correct directory on your system
 Check to make sure Input files are shown as “Exists”

» Click ‘OK’  (be patient while the system responds)
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SCAG Model Scenarios
Scenarios
» Manage scenario 

list
» Enter a description

Input, Output, 
Parameters
» Check/modify 

filenames and 
parameters
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Different Run Types
Feedback One Loop Assignment

Run Time 7-10 Days 1-2 Days < 1 Day
When to Run • To generate 

original SCAG 
model results

• To test large 
system wide 
network 
changes

• To test any 
SED changes

• To produce a 
final model 
dataset after 
alternatives 
analysis

• To test the 
impacts of 
small to 
moderate 
changes on 
mode choice

• This method 
will reduce but 
not eliminate 
oscillation 
noise

Usually only run 
when we need to 
understand 
transit changes

• To test the 
impacts of 
small to 
moderate 
changes on 
roadway 
volumes

• This method 
will nearly 
eliminate 
oscillation 
noise
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Example: When to run a full 5-
loop run

Receive new model inputs from SCAG
» We have input files from SCAG, but no outputs
» We want to generate outputs for further use

Run when people could change their 
decisions on:
» Where to work or shop
» Where to make typical daily trips

Example: High Desert Corridor
» Creates a large new freeway
» People could choose to make different trips
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Example: When to run a full 1-
loop run

Network alternatives that include transit, 
HOV, or HOT
» AND: You are interested in the effect on mode 

share 

Change in SED assumptions
» SED = Socioeconomic data
» Change HH or employment numbers by TAZ
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Example: When to run 
assignment only

Network alternatives that include general 
purpose roadway changes

Initial screening and alternatives comparison

This is the most common way the SCAG 
model is currently run
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Review: Mapping Basics
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Working with Layers
Start by opening a map or a geographic (dbd) layer 
file
» Opening a layer will create a new map and add the layer
» Opening a map will load all saved layers, settings, etc.

Access layers with the layers dialog box (      )

Bottom layer 
(drawn last)

Top layer 
(drawn first)



17

Display Manager
Activate from Map  Display Manager

Quick access to layers, settings, etc.
» Right-click for more settings, including make 

working layer
Hide/show a 

layer

Add/edit labels

Change a 
layer style

Bold text: links 
layer is active 

Node layer is 
NOT active 
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Creating Maps
Create a new map by opening a Geographic File (*.dbd)

Add more layers if desired
» then 

Choose the active layer
» Use the dropdown selector 
» Or use the display manager

Change the “default” styles for the layers
» then                , or       , or use the display manager

Hide or show layers
» or the display manager
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Color and Pattern Themes
Set feature colors and styles based on 
attributes
» Color Themes (      ) are often used to display 

facility type on a roadway network
» Pattern Themes (Map  Pattern Theme…) is 

sometimes used to display number of lanes on a 
roadway network
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Functional Class
Primary Facility Type Secondary Facility Type Primary Facility Type Secondary Facility Type

1 Freeways 10 Freeway
7 Minor Collector

70 Undivided
2 HOV

20 HOV 2 71 Divided

21 HOV 3+ 72 Continuous Left Turn

22 HOV - HOV Connector 73 Posted Speed 25
3 Expressway / Parkway

30 Undivided 74 Posted Speed 15

31 Divided, Interrupted
8 Ramps

80 Freeway to Freeway Connector

32 Divided, Uninterrupted 81 Freeway to arterial
4 Principal Arterial

20 Undivided 82 Arterial to freeway

41 Divided 83 Ramp Distributor

42 Continuous Left Turn 84 Ramp from Arterial to HOV
5 Minor Arterial

50 Undivided 85 Ramp from HOV to Arterial

51 Divided 86 Collector distributor

52 Continuous Left Turn 87 Shared HOV Ramps to MF
6 Major Col lector

60 Undivided 88 Truck only

61 Divided 9 Trucks 90 Truck only

62 Continuous Left Turn 100 100 Centroid Connector - Tier 1

200 200 Centroid Connector - Tier 2Source: SCAG Model 
Documentation, Appendix A
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Speed and Capacity
See Lookup tables in SCAG Validation Report
» Chapter 4
» Defines speed and capacity
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Functional Class
Two Digit FT Codes
» Contained in AB_Facility_Type and BA_Facility_Type
» Difficult to use for map editing setup (too many details)

One Digit FT Codes
» Not stored on the network
» Can be computed

TransCAD 
Formulas.txt
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Review 1a: Create a color theme for line layer using MAP_FT field

1. Open the SCAG Loaded Network File
 FileOpen, then in the file type dropdown next to ‘File name:’ select Geographic 

File(*.cdf,.*dbd) option
 Browse to 

C:\SCAG Training\assign\Outputs\scag_network_loaded.dbd

2. Add the MAP_FT Formula Field
 In TransCAD, go to DataviewFormula Fields

 Open C:\SCAG Training\TransCAD Formuals.txt in notepad 
(double-click from Windows Explorer)

 Copy the MAP_FT formula
 Paste the formula into the TransCAD formula field window
 Name the formula MAP_FT
 Click OK

3. On the top ribbon in TransCAD, click            it is called ‘color theme map 
wizard’

4. It opens up a dialog box with two tabs.  In the first tab ‘Settings’ tab:
 Click Load…

 Choose From Settings File
 Browse to and select SCAG Training\Settings.stg

 Choose MAP_FT and click OK, 

 Click OK again to complete the color theme dialog box
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Review 1b: Save your Map

1. Go to File  Save
 Browse to C:\SCAG Training
 Save the map as SR126 AQ.map

2. We will continue to modify our work and save this map
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Other Map Tools
Labels (     ) can be used to show attributes

Scaled Symbol Themes (     ) can be used to 
visualize data

Selection Sets can be used to:
» View/edit only selected data
» Change map formatting
» Show/Hide features
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Review 2: Add number of lanes labels

1. Start with the results from Review 1
Open the saved map if needed

2. Use the and zoom-in tool (      ) to zoom in to the 

area of interest

3. On the top ribbon, click the labels icon (        )
Select the [AB_AMLANES/BA_AMLANES] field

Change the size and color to match your preference

Change the format to have numbers by comma 

separated

Click ‘OK’ button

4. Save your changes in the map
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Review 3: Select and hide centroid connectors

1. Start with the results from Review 2
 Open the saved map if needed

2. In TransCAD, choose Tools
Selection or hit F9
 This will toggle the selection toolbox shown to 

the right
 Click select by condition (          )  to open the 

query builder
 Type in condition: MAP_FT >= 100
 Type the Set Name: Connectors

3. Hide Centroid Connectors
 Open selection settings (Selection  Settings 

or )
 Click on Connectors, 
 Click on Status until Connectors is Invisible
 Click Apply then Close

4. Save your changes in the map
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Data Tables (“Dataviews”)
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Working with dataviews
Open a dataview for any existing layer (     )

Open a standalone table with File  Open

Add/Remove fields with Dataview Modify Table 
» (or       )
» Be careful: Changes are permanent once you click “OK”

Data can be edited directly in the dataview
» Be careful: Changes are saved as you go

Create formula fields with 

Right-Click on a column header for more options
» Including a formula Fill 
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Formula Field vs. Add Field & Formula Fill
» Formula Fill adds new data and saves values in the table
» Formula Fields are updated when other values change, but are not 

stored in the data table
 Formula fields are stored in a map, dataview (*.dvw), or workspace (*wrk)

1. Enter a formula

2. Use the Field List to find 
field names

3. Name the formula field

Tip: nz([Field]) converts null
values to zero values

Working with Dataviews

1

2 3

Discussion: What is the difference between a formula field and fill?
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Joining Data
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Joining Data
Layers have an associated data table (     )
Data can be joined (     ) to other tables
» Roadway Network + Traffic Assignment results
» TAZ layer + Land Use Data
» Roadway Network + Lookup Table
» More…

This is how traffic assignment results are 
viewed in TransCAD
Fields cannot be added/removed from a 
joined view
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Joining Data
1. Select the Primary join table

» Be careful: Check the Field

2. Select the secondary join 
table

» Be careful: Check the Field

3. Create a name for the view, 
or use the default (do this 
last)

1

2

3

Tip: You can open a file from the join dialog box
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Highway Assignment
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Assignment Results
Basic Volumes
» Located on the Loaded Network
» Assign\Output\scag_network_loaded.dbd

Volume and Travel Time for: 
» Each Period 

(AM, MD, PM, NT, EVE)
» Total daily
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Assignment Results
Detailed Results in a separate table
» Join to the network using ID & ID1
» By time period or daily
» In the assign\Outputs folder

Processed version in ‘emission’
» Adjusted as part of SCAG’s air quality 

modeling process
» Can be used if desired, but be 

consistent within a project!



37

Assignment Results
Detailed Results include:
» Basics:

 Total Flow
 Flow by class (e.g., drive alone, shared ride, truck)
 Travel time and speed (congested time by period)

» Extras / Statistics:
 VMT (called V_Dist_T)
 VHT
 Volume to Capacity Ratio (“VOC”)
 PCE Values

» Select Link / Zone Results
 Only present if mode was run with 

assign\Inputs\SelectLink.qry
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Review 4: Join AM Assignment Results to the Network

1. Start with the results from Review 3
 Open the saved map if needed

2. Open the detailed AM assignment 
results
 Use File  Open
 Browse to Assign\Outputs\am_flow.bin

3. Create the join from Dataview
Join or 
 Left side: 16r16p_links and ID
 Right side: am_flow and ID1
 Click OK
 Remember: Do not close the joined view.

4. Use the info tool to review the 
results
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Assignment: Key Fields
*_Flow_PCE: Passenger Car Equivalent 
traffic flow. 
» Different types of vehicles have different PCE Vales

*_Time: Congested travel time (minutes)

*_VOC: Volume to Capacity Ratio (uses PCE)

*_V_Dist_T: Vehicle Miles Traveled

*_VHT: Vehicle Hours Traveled

*_Speed: Contested speed  (mph)



40

Assignment: Key Fields
*_VDF: Volume delay function results
» Same as time in the SCAG model
» Some models use different functions

*_Flow_[CLASS]: Flow by vehicle type
» Truck classes are duplicated (e.g., both LHDT and 

LIGHT_TRUCKS)
» Truck classes also show PCE values

AB_Flow / BA_Flow / TOT_Flow: 
“Final Answer” total flow values

(continued)
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Review 5: Mapping Challenge

1. Start with the results from Review 4
 Open the saved map if needed

2. Change labels to show % Truck on 
each link
 Use a formula field and labels together

3. Create a volume bandwidth theme
4. Change the color theme to reflect 

V/C Ratio
 Make links with >80% orange
 Make links with >90% red

5. Create and edit a legend
6. Put this map in a new layout

 Remember to add title, legend and date
 make this a report-ready layout
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Review 5 Solution
A solution file will be available separately
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Overview of the SR-126 
Project
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SR - 126
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The SR-126 Project
Project limit
» SR-126 from SR-150 to SR-23

Project
» Convert SR-126 from “continuous left turn arterial” 

to “fully divided arterial”

Opening Year
» 2022

Future Year
» 2040
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Links for the SR-126 Project 
AQ Analysis 

Presenter
Presentation Notes
16 miles long
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What Links should be included for 
an AQ Analysis

Project links 
Links connected to project links 
» Usually include links that are within one intersection of the 

project links

Optional: Links on alternative routes
» A project might introduce more traffic on project links due to 

higher capacities or free flow speeds, therefore leading to 
more Vehicle Miles Traveled (VMT) and possibly more 
emission. 

» However, this project should have reduced traffic on 
alternative routes, and then less emission on alternative 
routes. 

» In this situation, it is better to include links on alternative 
routes in the AQ analysis. 
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Overview of the Air Quality 
Analysis Process
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Air Quality Analysis Data Needs
Key information for an Air Quality (AQ) 
analysis

» Total Volume
» Truck Percent
» Congested Speed
» Vehicle Miles Traveled (VMT)
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Air Quality Analysis Data Needs
AQ Data for a Project 

Base Year

Opening Year No Build

Opening Year Build

Future Year No Build

Future Year Build

Base Year (2008 for SR-126)

Opening Year (2022 for SR-126)

Future Year (2040 for SR-126)
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SCAG Model Alternatives
AQ Data for SR-126

2008

2022 No Build

2022 Build

2040 No Build

2040 Build

SCAG 2012RTP

SCAG 2008 No Build

SCAG 2008 Build

SCAG 2035 No Build*

SCAG 2035 Build*

* For the SR-126 project, the official SCAG 2035 
model is the no build scenario, and a SCAG 
2035 build scenario model needs to be run (the 
traffic assignment step only).   
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Match of AQ Data Needs and 
SCAG Models

AQ Data for SR-126

2008

2022 No Build

2022 Build

2040 No Build*

2040 Build*

SCAG 2012RTP

SCAG 2008 No Build

SCAG 2008 Build

SCAG 2035 No Build

SCAG 2035 Build

Interpolation

Interpolation

* See the next slide
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Match of AQ Data Needs and 
SCAG Models

AQ Data for SR-126

2008

2022 No Build

2022 Build

2040 No Build

2040 Build

SCAG 2012RTP

SCAG 2008 No Build

SCAG 2008 Build

SCAG 2035 No Build

SCAG 2035 Build

Extrapolation

Extrapolation
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Procedures of Data Preparation 
for AQ Analysis

Re-run SCAG models
» Code the project in the network 
» Re-run the traffic assignment step only in most cases

Extract data from SCAG models (Practice 1)

Interpolate/extrapolate traffic volumes for opening 
year or future year (Practice 2)

Update congested speeds for the interpolated / 
extrapolated traffic volumes (Practice 3)

Format to generate the final output (Practice 4)
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Data Extraction Directly from 
the SCAG Model
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Steps to Extract Data Directly 
from the SCAG Model

Step 1: Navigate to the Project Location
» Purpose: Open the highway network and display project links
» TransCAD operations: 

 Open a geographic file 
 Navigate a map
 Show the node layer

Step 2: Assign and review project link IDs
» Purpose: Assign project link IDs to each link to be included in the AQ

analysis
» TransCAD operations: 

 Add a new field in the link attribute table
 Use the “info” tool to enter new link attributes
 Create a selection set by condition
 Create labels
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Steps to Extract Data Directly 
from the SCAG Model (continued)

Step 3: Copy link attributes to the AQ Excel file
» Purpose: Clean and organize the highway network dataview to show 

only what will be copied to the AQ Excel file
» TransCAD operations:

 Show only records of interest
 Show only fields of interest
 Sort records in TransCAD
 Copy and paste

Step 4: Copy project link IDs to traffic assignment tables
» Purpose: Copy project link IDs from the highway network dataview to 

traffic assignment tables, which will be used in Step 5
» TransCAD operations: 

 Open a *.bin file
 Create a joint view 
 Fill a field using “Formula”
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Steps to Extract Data Directly 
from the SCAG Model (continued)

Step 5: Copy traffic assignment results to the AQ
Excel file
» Purpose: Clean and organize traffic assignment tables to show only 

what will be copied to the AQ Excel file
» TransCAD operations

 Show only records of interest
 Show only fields of interest
 Sort records in TransCAD
 Copy and paste
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Practice 1: Create and fill the 2008 AQ Excel file

1. Open the SCAG 2008 working geographic network file in TransCAD
 In TransCAD, File  Open, then in the file type dropdown next to ‘File name:’ select Geographic File (*.cdf; *.dbd) option
 Browse to the folder where the 2008 working geographic network file is: \AQ Training Material\SCAG 2012RTP 2008 BY Scenario\networks\Outputs
 Select the ‘scag_network_working.dbd’ and click ‘Open’ button. 

2. Navigate the map to show the SR-126 project area
 Use the tools on the toolbox to navigate the map to the SR-126 project area (red area in the two figures to the right)
 Use          to zoom in,          to zoom out and      to pan. If the toolbox is not shown, press F8 to bring it up
 If it is hard to locate the links, following these steps to locate one of the links on SR-126:
» Click         on the top ribbon in TransCAD
» On the “Find” popup window, select “Map Feature”, select “SCAG_BY08_links” as Layer, select “ID” as Field,

enter 25364 in Value, and Click “OK”. The map then zoom to show Link 25364, which is one of the links on
SR-126.

3. Show the node layer in the map to see where each link starts and ends
 In TransCAD, Map  Layers 
 On the Layers popup window, select Node and click the “Show Layer” button 
 On the Layers popup window, select the line layer (“SCAG_BY08_links”) to make it as the active layer
 Click the “Close” button to close the Layers popup window

Step 1: Navigate to the SR-126 Project Location
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Project Link IDs used in the Practice
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Practice 1: Create and fill the 2008 AQ Excel file

1. Add a new field for project link ID in the link attribute table
 In TransCAD, Dataview  Modify Table
 On the popup window, click button “Add Field” to add a new field
 Change Field Name to Proj_Link_ID
 Change Type to Integer (2 bytes)
 Click button “OK” to apply the change and close the popup window

2. Assign project link IDs one by one
 Start from the west end of the SR-126 project links
 Click      on the toolbox and click a project link 1 to open its

information window. If the toolbox is not shown, press F8 on 
keyboard to bring it up.

 On the information window, scroll down to the bottom, and enter 1 in 
Proj_Link_ID.

 Repeat the above two operations for the rest of links. The target is 
that all 13 links have the Proj_Link_ID as shown in the slide of 
“Project Link IDs used in the Practice”.

3. Create a selection set to make sure the project link IDs have been entered correctly.  
 On the selection toolbox, click          to open the “Select by Condition” popup window. If the selection toolbox is now shown, press F9 on the 

keyboard to bring it up.
 In the “Select by Condition” popup window, enter Proj_Link_ID > 0 in the textbox “Enter a Condition”, and click the “OK” button to create a new 

selection and close the popup window.
 Check whether the new selection set includes all 13 links. If not, repeat sub-step 2 (assign project link IDs) shown above to assign project link IDs to 

the missing links. Re-create the new selection set by using the condition of “Proj_Link_ID > 0”. Repeat until all 13 links are in the new selection set.
 Check whether the new selection includes any links that are not needed for the AQ analysis. If it does, use       on the toolbox and click on the link 

that should not be included to open its information window, from which delete the value in Proj_Link_ID. Re-create the new selection set by using the 
condition of “Proj_Link_ID > 0”. Repeat until the new selection does not include any links that are not needed for the AQ analysis.

Step 2: Assign and review project link IDs
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Practice 1: Create and fill the 2008 AQ Excel file

4. Label the links in the selection set with project link IDs to make sure the project link IDs have been entered correctly
 On the selection toolbox, click          to open the “Selection Sets” popup window. If the selection toolbox is now shown, press F9 on the keyboard to 

bring it up.
 On the “Selection Sets” popup window, click on the row for Selection, and click the 

button “Labels” to only label the links in the selection set. 
 On the new popup window “Labels”, select “Proj_Link_ID” for Field, enter 12 for 

Size, and click button “OK” to close the popup window “Labels”. 
 Click the “Close” button on the “Selection Sets” popup window to apply the labels and 

close the “Selection Sets” popup window. 

Step 2: Assign and review project link IDs (continued)

5. Review the label of project link IDs for each link in the selection set.  If the 
project link IDs for a link need to be changed, use      on the toolbox to 
bring up its information window and modify the value for “Proj_Link_ID”.
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Practice 1: Create and fill the 2008 AQ Excel file

1. Open the dataview for the SCAG highway network
 On the menu bar, click on          to open the dataview for the SCAG highway network

2. Show only selected links in the dataview
 On the menu bar, select “Selection” from the drop down list to, then only the links in the 

selection set are shown in the dataview

3. Show only fields to be included in the AQ Excel file
 Choose Dataview  Field Sets on the TransCAD menu to open the popup window “Field Sets”
 Click the “Add” button on the popup window “Field Sets”
 On the new popup window “Define Field Set”, click the “Clear” button to clear all fields from the right box
 Click on a field in the left box, then click the “Add>>” button to add it to the right box
 Repeat to add all fields of interest to the right box, as shown below
 Use the “Move Up” and “Move Down” button to adjust the order of fields in the right box to be in exact the same order as shown below
 “Filter” can be used to facilitate locating the field. The left box only shows the fields that contains the characters in the “Filter”
 Click the “OK” button and enter the field set name. Click “OK” to close the popup window “Field Sets” and apply the changes. 

Step 3: Copy link attributes to the AQ Excel file
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Practice 1: Create and fill the 2008 AQ Excel file

4. Sort the records by Project Link ID
 Right click any cell in the field of “Proj_Link_ID” to bring up a popup window as shown to the right, 

select “Sort Increasing” to sort the records in an increasing order of “Proj_Link_ID”

5. Open the AQ Excel file
 In Excel, open the AQ Excel file which is \AQ Training Material\AQ Data\ SR-126 Air Quality V1.xlsx
 This Excel file has the headers and the description of each link, but other fields are all empty

6. Copy link attributes from the dataview in TransCAD to the AQ Excel file
 On the dataview in TransCAD, click and drag to select all records and all but the first field
 Right click on the selected area, and click Copy on the popup window
 Right click on Cell E4 in Excel, and click on             on the popup window to paste to the AQ Excel file

7. Close the dataview in TransCAD by clicking on the upper right corner 

Step 3: Copy link attributes to the AQ Excel file (continued) 
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Practice 1: Create and fill the 2008 AQ Excel file

1. Open the Traffic Assignment File (am_flow.bin) in TransCAD
 In TransCAD, File  Open, then in the file type dropdown next to ‘File name:’ select Fixed-format Binary File (*.bin) option
 Browse to the folder where the 2008 traffic assignment bin files are located: \AQ Training Material\SCAG 2012RTP 2008 BY Scenario\Assign\Outputs
 Select the ‘am_flow.bin’ and click ‘Open’ button 

2. Add a new field for project link ID in the traffic assignment table
 In TransCAD, Dataview  Modify Table
 In the popup window, click button “Add Field” to add a new field
 Change Field Name to Proj_Link_ID
 Change Type to Integer (2 bytes)
 Click button “OK” to apply the change and close the popup window

3. Create a joint dataview
 In TransCAD, Dataview  Join to open the popup window “Join”
 On the popup window “Join”, specify Joining from Table and Field, and To Table and Field

based on the figure shown to the right
 Click button “OK” to apply the settings and close the popup window

4. Fill the “Proj_Link_ID” field in the traffic assignment table
 On the joint dataview, right click on the header of the last 

field “am_flow.Proj_Link_ID”, and click on “Fill”
 On the popup window “Fill”, choose “Formula”
 On the popup window “Formula”, select 

“SCAG_BY08_links.Proj_Link_ID” in the “Field List”
drop down list. “SCAG_BY08_links.Proj_Link_ID” can 
also be typed in the text box directly.

 Click the “OK” button on the popup window “Formula”
 Click the “OK” button on the popup window “Fill”
 Close the joint dataview.

Step 4: Copy the project link IDs to the traffic assignment table
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Practice 1: Create and fill the 2008 AQ Excel file

1. Make a selection set of links to be included in the AQ analysis in the traffic assignment table
 Make the dataview am_flow as the active window
 Uses the selection toolbox to select links to be included in the AQ analysis
 On the selection toolbox, click          to open the “Select by Condition” popup window. If the selection toolbox is now shown, press F9 on the keyboard to 

bring it up.
 On the “Select by Condition” popup window, enter Proj_Link_ID > 0 in the textbox “Enter a Condition”, and click the “OK” button to create a new 

selection and close the popup window.

2. Show only fields to be included in the AQ Excel file
 Choose Dataview  Fields on the TransCAD menu to open the popup window “Dataview Fields”
 On the popup window “Dataview Fields”, click the “Clear” button to clear all fields from the right box
 Click on a field in the left box, then click the “Add>>” button to add it to the right box
 Repeat to add all fields of interest to the right box, as shown below
 Use the “Move Up” and “Move Down” button to adjust the order of fields in the right box to be in exact the same order as shown below
 “Filter” can be used to facilitate locating the field. The left box only shows the fields that contains the characters in the “Filter”
 Click “OK” to close the popup window “Dataview Fields” and apply the changes. 

Step 5: Copy traffic assignment results to the AQ Excel file
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Practice 1: Create and fill the 2008 AQ Excel file

4. Sort the records by Project Link ID
 Right click any cell in the field of “Proj_Link_ID” to bring up a popup window as shown to the right, 

select “Sort Increasing” to sort the records in an increasing order of “Proj_Link_ID”

5. Open the AQ Excel file (if it is not open)
 In Excel, open the AQ Excel file which is \AQ Training Material\AQ Data\ SR-126 Air Quality V1.xlsx

6. Copy traffic assignment results from the dataview in TransCAD to the AQ Excel file
 On the dataview in TransCAD, click and drag to select all records and fields of interest
 Right click on the selected area, and click Copy on the popup window
 Paste to the corresponding cells in the AQ Excel file

7. Close the traffic assignment dataview in TransCAD by clicking on the uper right corner 

8. Use formulas in Excel to calculate the “Truck Percent” and “Vehicle Miles Traveled” in the AQ Excel file
 “Truck Percent” = (“Light Heavy Duty Vehicles” + “Medium Heavy Duty Vehicles” 

+ “Heavy Heavy Duty Vehicles”) / “Total Vehicles”
 “Vehicle Miles Traveled” = “Length” * “Total Vehicles”

Step 5: Copy traffic assignment results to the AQ Excel file (continued)
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Work with Traffic Volumes not 
directly from SCAG Models
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Work with Traffic Volumes not 
directly from SCAG Models

When the traffic volumes from SCAG models need to 
be adjusted
» Example: SCAG models consistently underestimate the traffic 

volumes on a corridor
» Solution: to apply a factor to traffic volumes from SCAG models

When the opening year or future year of a project is 
not modeled by SCAG. 
» Example: the opening year of SR-126 is 2022, and a 2022 SCAG 

model does not exist
» Solution: to interpolate or extrapolate based on existing SCAG 

models.
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Examples of Applying a Factor to 
SCAG Traffic Volumes

𝑉𝑉𝑖𝑖
2035_𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝=Adjustment_Factor × 𝑉𝑉𝑖𝑖

2035_𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

𝑉𝑉𝑖𝑖
2035_𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 is the post processed 2035 traffic volume on Link 𝑖𝑖. 

𝑉𝑉𝑖𝑖
2035_𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 is the 2035 traffic volume directly from SCAG models on 

Link 𝑖𝑖. 

Traffic volumes could be 
» Total Vehicles
» Total PCE
» Light Heavy Duty Vehicles
» Medium Heavy Duty Vehicles
» Heavy Heavy Duty Vehicles
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Examples of Interpolation of 
Traffic Volumes

𝑉𝑉𝑖𝑖𝑛𝑛 is the traffic volume for Year 𝑛𝑛 on Link 𝑖𝑖. It could be

» Total Vehicles
» Total PCE
» Light Heavy Duty Vehicles
» Medium Heavy Duty Vehicles
» Heavy Heavy Duty Vehicles

𝑉𝑉𝑖𝑖2022=𝑉𝑉𝑖𝑖2008 + 2022−2008
2035−2008

× (𝑉𝑉𝑖𝑖2035 − 𝑉𝑉𝑖𝑖2008)



31

Examples of Extrapolation of 
Traffic Volumes

𝑉𝑉𝑖𝑖2022=𝑉𝑉𝑖𝑖2008 + 2040−2008
2035−2008

× (𝑉𝑉𝑖𝑖2035 − 𝑉𝑉𝑖𝑖2008)

𝑉𝑉𝑖𝑖𝑛𝑛 is the traffic volume for Year 𝑛𝑛 on Link 𝑖𝑖. It could be

» Total Vehicles
» Total PCE
» Light Heavy Duty Vehicles
» Medium Heavy Duty Vehicles
» Heavy Heavy Duty Vehicles
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Overview of Practice 2
Practice 2 is to calculate the 2022 No Build traffic 
volumes by interpolating 
» the 2008 No Build traffic volumes
» the 2035 No Build traffic volumes

Practice 1 generated the 2008 No Build traffic 
volumes

Repeat Practice 1 on the 2035 working network and 
the 2035 traffic assignment results to get the 2035 No 
Build traffic volumes (we have done this for you)

All work is done in Excel
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Practice 2: Calculate the 2022 No Build Traffic Volumes by 
interpolating the 2008 and 2035 No Build Traffic Volumes

1. Open the Excel file that contains the 2008 and 2035 No Build traffic volumes
 The Excel file is: \AQ Training Material\AQ Data\SR-126 Air Quality V2.xlsx

2. Create a new sheet “2022 NB”

3. Copy the entire sheet “2035 NB” and paste to the sheet “2022 NB”, so that we have all the headers and descriptions
 In the sheet “2035 NB”, click the upper left corner of the spreadsheet to select the entire spreadsheet
 Press Ctrl + C on the keyboard to make a copy of the entire spreadsheet
 In the sheet “2022 NB”, click the cell A1 

 Press Ctrl + V on the keyboard to paste to the sheet “2022 NB”

4. In Excel, calculate the 2022 No Build traffic volumes by interpolating the 2008 and 2035 No Build traffic volumes
 Use the formula shown on the slide “Examples of Interpolation of Traffic Volumes” to calculate
 Need to calculate these traffic volumes for both AB and BA direction

 Total Vehicles
 Total PCE
 Light Heavy Duty Vehicles
 Medium Heavy Duty Vehicles
 Heavy Heavy Duty Vehicles

 Sample formula to be used in Excel
For cell Q4 in sheet “2022 NB”, the formula is ='2008 NB'!Q4+(2022-2008)/(2035-2008)*('2035 NB'!Q4-'2008 NB'!Q4)

5. In Excel sheet “2022 NB”, the columns for “Truck Percent” and “Vehicle Miles Traveled” should have been updated automatically since
these columns contain formulas. If not, use Excel formulas to update them. 
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Update Congested Speed
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Update Congested Speeds
Congested speed is calculated based on volume-
delay function

𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 =
𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹 𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹 𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆

1 + 𝛼𝛼 × ( 𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶)𝛽𝛽

Where:
𝛼𝛼 and 𝛽𝛽 are parameters
𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉: total PCE volume for a time period
Capacity: total capacity on all lanes for a time period
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Update Congested Speeds

Congested speed is not a linear function of volume, 
so it is the best to use the volume-delay function to 
update congested speeds
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Parameters for the Volume-Delay 
Function

Should be 4.0

From the SCAG model documentation:
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1. Open the Excel file that contains the 2008, 2035 and 2022 No Build traffic volumes
 The Excel file is: \AQ Training Material\AQ Data\SR-126 Air Quality V3.xlsx

2. In sheet “2022 NB”, calculate the “AB AM VOC” and “BA AM VOC”
 AB AM VOC = AB AM Total PCE / AB CAPA AM (e.g. the formula for cell AG4 is =R4/O4)
 BA AM VOC = BA AM Total PCE / BA CAPA AM (e.g. the formula for cell AJ6 is =Z6/P6)

3. In sheet “2022 NB”, determine the values for “AB AM Alpha”, “AB AM Beta”, “BA AM Alpha” and “BA AM Beta” based on the slide 
“Parameters for the Volume-Delay Function”, VOC, facility type and area type.
 Can use “Filter” in Excel to help group records with the same values for Alpha and Beta 

4. In sheet “2022 NB”, calculate the congested speed
 Sample formula to be used in Excel

The formula for cell U4 is =K4/(1+AF4*AE4^AG4)

Practice 3: Calculate the Congested Speeds for 2022 No Build Scenarios

1. Click here to highlight 
Row 3

2. Turn on the Filter

3. Click here to see the 
list of unique values for 
AB Facility Type

4. Only check the values that should 
be shown. In this example, only 
records with AB Facility Type = 40 or 
42 will be shown, so it is easy to treat 
them as a group. 

5. Can repeat step 3 and 4 for 
another column. For example, we 
can show only records with “AB 
Facility Type = 40 or 42” and “AB 
Area Type = 4”
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Format results to Generate 
the Final Output
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Review of the Procedures to 
Prepare Data for AQ Analysis
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Procedures of Data Preparation 
for AQ Analysis

Re-run SCAG models
» Code the project in the network 
» Re-run the traffic assignment step only in most cases

Extract data from SCAG models (Practice 1)
» Define project links 
» Extract data from traffic assignment results

Interpolate/extrapolate traffic volumes for opening 
year or future year (Practice 2)

Update congested speeds for the interpolated / 
extrapolated traffic volumes (Practice 3)

Format results to generate the final output (Practice 4)

In current AQ Tool

Could be added to the AQ Tool

Could be added to the AQ Tool
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